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Editing Stereoscopic 3D in Vegas Pro 10 

Vegas Pro 10 has a very flexible and powerful stereoscopic 3D (S3D) workflow. This document will describe each of the S3D features in 
detail so you can quickly apply them to your own S3D workflow. 

There are six basic steps to editing S3D in Vegas Pro 10: project setup, media import, previewing and monitoring, alignment and 
adjustments, editing, and final output. This document will explain each step in detail and then also discuss additional S3D functionality 
available in Vegas Pro 10. 

Project setup 
Creating an S3D project is easy. Choose File > Properties to open the Project Properties dialog, click the Video tab, and choose a setting, 
such as Anaglyphic (red/cyan), from the Stereoscopic 3D mode drop-down list. 

This setting will be used by default for Video Preview, External Monitor, and for rendering, but as you will see later, each can also be 
individually set. 

Media import 
Vegas Pro 10 supports S3D media in the following formats: 

Video shot on two cameras 

When shooting S3D using a pair of cameras, it is important to record a synchronizing event and/or use synchronized timecode. For a 
synchronizing event, use a professional slate or just clap or snap your fingers in front of the cameras. If you are shooting with cameras 
that can take a timecode source, feed them both with synchronized timecode and you won't need any of these additional techniques 
except as a backup. 

If you used synchronized timecode, select a pair of left/right clips in the Project Media window, right-click one of the selected clips, and 
choose Pair as Stereoscopic 3D Subclip from the shortcut menu. When used in the Project Media window, this command uses the 
timecode in each clip to create a synchronized S3D subclip. 

If your clips do not have synchronized timecode, you will need to use your synchronizing event to align the clips. 

1.	 Add your media to the timeline using Add Across Tracks mode so the left-eye track is above the right-eye track. 

2.	 If you used a slate or a loud clap for your synchronization point, you can align the events to within a frame of each other using the 
audio waveforms: 

a.	 Roughly align the audio waveforms by dragging events in the timeline. The synchronization sound will appear as a 
distinct spike in the audio waveform. 

b.	 Use the Zoom controls at the bottom-right corner of the timeline to zoom in on the waveform. 

c.	 Verify Quantize to Frames is enabled because you want video frames to be aligned even if the audio is slightly out of 
alignment. 
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d.	 Drag a track’s border to make the tracks taller and view large waveforms. 

e.	 Use Shift+Up Arrow to magnify the waveforms if necessary. 

f.	 Click the event you want to move and press 1 or 3 on the numeric keypad to nudge the event by frames to the left or 
right. 

For final alignment, set the opacity of the top track to 50%, find an area with good movement in the video, and verify it is 
moving the same in both views and that one view does not lead the other. 

If the cameras were not genlocked together (shooting at the same cadence), you may find one to be up to half a frame 
ahead of the other. Unless your scene has lots of fast motion, this is acceptable; just be sure to get them as close as 
possible on the timeline. 

3.	 Select both video events, right-click one of the events, and choose Pair as Stereoscopic 3D Subclip. 

One video event is deleted from the timeline, the active take for the event is set to the new multistream subclip, and a new 
multistream clip is added to the Project Media window. If you view the clip properties for the new subclip, you’ll see that the 
Stereoscopic 3D Mode is set to Pair with next stream. 

4.	 Perform the previous steps for each pair of clips, and then delete the audio and video tracks. 

After completing either synchronization method, you will have paired stereoscopic subclips in the Project Media window. You can 
identify them by their long name that includes the names of the source clips. Drag these in the order you need them to the timeline. You 
now have S3D media in an S3D project. 

If your camera rig used mirrors or inverted cameras and produced flipped or rotated images that were not corrected in camera, you can 
easily correct for this. For more information, see Alignment and Adjustments on page 5. 

Video in a frame-compatible format 

Sometimes, S3D content needs to move through an existing 2D pipeline, such as for broadcast, satellite, DVD, or IPTV. To do this, the left-
and right-eye views are compressed in some fashion and the result is a standard video frame that can move through existing 
infrastructure and expanded back out into separate views for display on the other end. 

Common methods for frame-compatible distribution are called side by side, where the left- and right-eye views are squeezed 
horizontally and occupy the left and right halves of the video frame, and top/bottom, where the left- and right-eye views are squeezed 
vertically and occupy the top and bottom halves of the video frame. Some older 3D distribution formats also used line-alternate 
encoding that stored the left- and right-eye views in each field of interlaced video. In this case, the left- and right-eye views are squeezed 
vertically and then woven together every other line to form the video frame. This content looks a lot like interlaced video but, instead of 
the video fields representing different points in time, they are the left- and right-eye views. 

Vegas can decode these forms of frame-compatible S3D media into discrete left- and right-eye views. Add the media to the Project 
Media window (or to the timeline), right-click, and choose Properties. Then, on the Media tab, set the Stereoscopic 3D mode to match 
the source format: Side by side (half), Top/bottom (half), or Line alternate. If the views need to be swapped, use the Swap Left/Right 
check box. 
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Stills or video with two full-sized views 

S3D Photography often uses JPEG or PNG format images with two paired views that are not squeezed. You may see these files with an 
extension of .JPS or .PNS. Also, some video formats that are flexible in frame size (such as WMV and QuickTime) are used to represent 
S3D content in a similar fashion. Vegas can also import these S3D formats. 

Add the media to the Project Media window (or to the timeline), right-click, and choose Properties. Then, on the Media tab, set the 
Stereoscopic 3D mode to Side by side (full) or Top/Bottom (full). If the views need to be swapped, use the Swap Left/Right check box. 

Video in CineForm Neo3D format 

If you have media in CineForm® Neo3D™ format — because it was delivered in that format (for example, from Mammoth3D), or because 
you used CineForm FirstLight™ to synchronize and pair clips — you can drop this media on an S3D timeline with no additional work. 

Make sure to have version 5.1 or later of CineForm NeoHD™, Neo4K™, Neo3D™, or the free NeoPlayer™ installed. CineForm updates their 
codec from time to time, so check for the latest version for best performance and results. 

Video with two streams 

Some S3D cameras record in a video format with two streams. If you have media from such a camera, you can add the media to an S3D 
timeline with no additional work. 

When this media is added to an S3D project, Vegas puts the first stream on the timeline and automatically sets the stereoscopic 3D 
mode to Pair with next stream. If the views need to be swapped, use the Swap Left/Right check box. 
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Previewing and monitoring 
If you chose Anaglyphic (red/cyan) from the Stereoscopic 3D mode drop-down list in the Project Properties dialog and added S3D 
media to the timeline, wearing a pair of red/cyan anaglyphic glasses will allow you to see only the left eye video in your left eye and right 
eye video in your right eye. You should be able to see some stereo effect as in the following image: 

In addition to the anaglyphic formats — which work on nearly any color display — Vegas supports other S3D display formats. 

By default, the Video Preview and External Monitor will both use the project's stereoscopic 3D mode.  However, if you wish to use one 
format for the Video Preview window and another for your external monitor, you can easily do this. Open the Video tab in the 
Preferences dialog (Options > Preferences > Video) and use the Stereoscopic 3D mode setting to override the Video Preview window 
setting. 

For example, if you have an external 3D display, you might want to set the Video Preview to Left only while editing. Open the Preview 
Device tab in the Preferences dialog (Options > Preferences > Preview Device) and use the Stereoscopic 3D mode setting to override 
the external monitor display setting. You would do this if you have a stereoscopic 3D monitor you always want to drive in the same way 
regardless of the S3D mode your project is using. 

If you have a stereoscopic 3D monitor, Vegas supports it in the following ways: 

Line alternate passive 3D monitor 

There are a number of LCD monitors available that take a line-alternate encoding and present the odd-numbered lines to one eye and 
the even-numbered lines to the other when the viewer is wearing passive (polarized) 3D glasses. On the Preview Device tab in the 
Preferences dialog, choose Stereoscopic 3D Graphics Card from the Device drop-down list, and then choose Line alternate from the 
Stereoscopic 3D mode drop-down list. You may need to select the Swap Left/Right check box if the left/right eye views are reversed. 

When using the Stereoscopic 3D Graphics Card setting, the line-alternate encoding will be correct regardless of your project resolution 
or Video Preview size. The line-alternate mode can also be used with other Device settings, but you will need to match your project 
resolution to your display resolution and only use full-sized display modes in the Video Preview, or the line-alternate encoding will be 
scaled and won't work correctly. 

Side-by-side or top/bottom compatible television or production monitor 

Nearly all late-model 3D televisions and some 3D production monitors can take an S3D signal in side-by-side or top/bottom format. You 
can use an HDMI or SDI connection (respectively) to drive these displays. 

Use the display's configuration menus to put it in the correct S3D input mode. On the Preview Device tab in the Preferences dialog, 
choose Side by side (half) or Top/bottom (half) from the Stereoscopic 3D mode drop-down list. 
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Older DLP rear-projection television 

Some older DLP-based rear-projection 3D televisions use a checkerboard format to encode the 3D signal. On the Preview Device tab in 
the Preferences dialog, choose Stereoscopic 3D Graphics Card from the Device drop-down list and choose Checkerboard from the 
Stereoscopic 3D mode drop-down list. When using the Stereoscopic 3D Graphics Card setting, the checkerboard encoding will be 
correct regardless of your project resolution or Video Preview size. The checkerboard mode can also be used with other Device settings, 
but you will need to match your project resolution to your display resolution, and only use full-sized display modes in the Video Preview, 
or the checkerboard encoding will be scaled and won't be decoded correctly. 

nVidia 3D Vision for Quadro or 3D Vision Pro 

With an nVidia Quadro graphics card and compatible 120 Hz LCD monitor and active glasses, you can view S3D using the 3D Vision for 
Quadro or 3D Vision Pro system. Follow the setup instructions on the nVidia Web site (http://www.nvidia.com/object/ 
quadro_pro_graphics_boards.html). On the Preview Device tab in the Preferences dialog, choose Stereoscopic 3D Graphics Card from 
the Device drop-down list and choose Left and Right from the Stereoscopic 3D mode drop-down list. 

Alignment and Adjustments 
It is very important that S3D content have differences between the views only in horizontal displacement. Any vertical misalignment or 
rotational misalignment will detract from the viewing experience, and may even cause headaches or nausea. Also, it is important to limit 
the amount and direction of horizontal offset to create comfortable S3D depth. For example, when shooting with parallel-axis cameras 
with no in-camera convergence, the horizontal displacements result in all of the depth range in front of the screen plane, which would 
be uncomfortable to view, so you need to use horizontal image translation to push most of it behind the screen plane. It is beyond the 
scope of this document to go into greater depth, so please refer to a good book on the subject, such as 3D Movie Making: Stereoscopic 
Digital Cinema from Script to Screen by Bernard Mendiburu (http://www.amazon.com/3D-Movie-Making-Stereoscopic-Digital/dp/ 
0240811372). 

Vegas Pro 10 includes a tool for making these alignments and adjustments quickly and easily. From the Video FX window, drag the 
Stereoscopic 3D Adjust effect onto an event or track header (depending on what scope you want the adjustment to have; you can also 
apply Stereoscopic 3D Adjust to the media in the Project Media window). 

For horizontal image translation (to push the range of S3D depth into or out of the screen), use the Horizontal Offset slider. 

If your images have any vertical misalignment, open the Corrections section and use the Vertical Offset, Zoom, Keystone, or Rotation 
sliders to fix it, or click the Auto Correct button and let Vegas Pro 10 automatically set the controls to minimize vertical misalignment. 
This feature works best when the cursor is parked at a frame that has a good variety of features at various depths. 

Use the 3D glasses, in combination with viewing the output without the glasses, to create good alignment and good depth settings. You 
usually want all of the depth behind the screen plane, only crossing the screen plane for dramatic or special effect. However, make sure 
never to create divergence, where the left-eye picture would appear more than 2.5" to the left of the right-eye picture on the largest 
screen your movie will ever be shown on. For example, if the largest screen to be used is 16:9 with a 106-inch diagonal, the width is 87% 
of the diagonal, or about 92 inches. With 1920x1080 content, 2.5 inches is only 52 pixels, so make sure your distant objects are never 
more than 52 pixels apart. 

For alignment, the Difference S3D mode can be helpful to show when features are well aligned in each eye. If you move the Horizontal 
Offset slider while in Difference mode, you can sweep through the objects at various depths and see the alignment for each one. 

Stereoscopic 3D Adjust also has settings to flip the views horizontally and/or vertically, which is useful for certain S3D cameras rigs that 
use mirrors. Flipping both axes is the same as 180 degree rotation. 

Stereoscopic 3D Adjust can also be applied to 2D media in an S3D project. Use the Horizontal Offset slider to set the planar depth of the 
2D video. When working with 2D titles or overlay graphics with alpha transparency, you may want to clear the Automatic Crop check 
box. For more complex 3D placements of 2D media in an S3D project, see Stereoscopic 3D camera for 3D track motion on page 8. 

Editing 
Edit your S3D project as you would a 2D project. All of the editing tools — including multicamera, takes, pan/crop, effects, transitions, 
track motion, compositing, parent/child tracks, etc. — work in an S3D project. You can edit in left only or right only mode, but check 
your S3D depth for every shot and also check to make sure there are no large depth changes between shots as these will be difficult for 
the viewer's eyes to track, which can cause fatigue and discomfort. 
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Final output 
Vegas Pro 10 can deliver your S3D project in a variety of formats: 

Video in a frame-compatible format 

Frame-compatible formats allow S3D content to move through an existing 2D pipeline, such as broadcast, satellite, DVD or IPTV. For 
more information about this process, please see Video in a frame-compatible format on page 2. 

Vegas can create these forms of frame-compatible S3D for your final output. You can set your project to one of these modes — Side by 
side (half), Top/bottom (half), or Line alternate — and render using a standard file format template, or you can create a custom 
template that will always use this mode regardless of the project’s S3D mode. 

The custom template is convenient if you plan to deliver this format again in the future. In the Render As dialog, select the desired 
format and starting template, then click the Custom button. In the Project tab, set the stereoscopic 3D mode, give the custom template 
a descriptive name, and click the Save Template button. In the future, just select this template when rendering and it will use your 
selected S3D mode. 

Two files 

You can render two separate files for delivering S3D content manually by setting the stereoscopic 3D mode to Left only, rendering, then 
setting the stereoscopic 3D mode to Right only and rendering again. 

You can use the Batch Render script to automate the process. Create two custom rendering templates: for one template, set the 
stereoscopic 3D mode to Left only and set the other template’s stereoscopic 3D mode to Right only. Then choose Tools > Scripting > 
Batch Render, select your format and select the check box for your two templates, set the destination folder and file name, and click OK. 
Vegas will render each file with the name of the template appended to the file name. 

CineForm® Neo3D™ format 

If you own CineForm NeoHD, Neo4K, or Neo3D, you can render to the CineForm Neo3D format using a AVI or QuickTime container. In the 
Render As dialog, select the Video for Windows (*.avi) or QuickTime (*.mov) format, click the Custom button, set your desired frame 
format and frame rate (or start with a template that matches these), and choose CineForm Codec from the Video format drop-down list. 
Save this template with a descriptive name for use in the future. 
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YouTube 3D 

YouTube 3D uses frame-compatible video, so follow the instructions Video in a frame-compatible format on page 6 to create a custom 
template for the format of your choice that is also compatible with YouTube (such as XDCAM EX, Windows Media Video, or MainConcept 
MPEG-2). 

For the custom template, set the stereoscopic 3D mode to Side by side (half) and select the Swap Left/Right check box since YouTube 
3D defaults to this layout. 

When you upload your video to YouTube, add yt3d:enable=true as a tag to enable 3D viewing. Also add yt3d:aspect=16:9 (or 
yt3d:aspect=4:3) to set the viewing frame aspect ratio. 

Note: Instead of using the Swap Left/Right check box, you can add yt3d:swap=true to override the default view placement. 

DVD, Blu-ray Disc, and 3D Blu-ray Disc 

You can burn a standard Blu-ray Disc™ or DVD in side-by-side format (see Video in a frame-compatible format on page 6) and play it on 
any Blu-ray Disc or DVD player. When the player is connected to a recent 3D TV, you can use the TV's menu to put it into side-by-side 
mode and enjoy 3D playback. 

If your goal is the higher-end Blu-ray 3D™ format, Vegas Pro 10 can prepare content in full HD per-eye format by rendering two separate 
files (see Two files on page 6), which can be read by an MVC encoder such as the Dualstream 3D encoder (http:// 
www.sonycreativesoftware.com/blurayencoding) and authored using a tool such as Blu-print 6 (http://www.sonycreativesoftware.com/ 
bluprint). 
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Additional S3D features 
In addition to the S3D workflow described above, Vegas Pro 10 has some additional S3D features you may find useful in your project. 

Per-eye video effects 

If you wish to apply color correction separately for each view, it's easy in Vegas Pro 10. Apply two instances of the Color Corrector plug-
in. In the plug-in chain, you'll see two Enable check boxes where there is usually one for 2D projects. These allow you to separately 
control video effects for each eye. 

In addition to being used for color correction, some interesting S3D effects can be achieved by using the same plug-in with slightly 
different settings in each view. For example, Rays can be used with slightly different X position settings to make the light rays offset in 
each eye, which produces a stereoscopic light rays effect with semirealistic depth. 

Stereoscopic 3D camera for 3D track motion 

When using the 3D track compositing feature of Vegas Pro 10, the layering and compositing of those tracks can have true S3D depth. 

In addition to simple depth plane adjustments of 2D media (as described in Alignment and Adjustments on page 5), you can now place 
2D tracks in 3D space (including tilted back) and add S3D depth to them as in the following image: 

When a track’s compositing mode is set to 3D Source Alpha, a Stereoscopic 3D Camera section has been added to the Track Motion 
dialog. 

The Lens Separation parameter is used to set the interaxial distance of the stereoscopic 3D camera used for rendering 3D tracks. The 
units are specified as a percentage of frame width (and are therefore resolution independent). For presentation on a 40" HDTV, the Lens 
Separation setting typically this would not exceed 7%; for theatrical projection, 0.5%. 

The Depth Adjust parameter is used to shift the images horizontally to set the perceived depth. By default, a setting of zero represents 
screen depth. 

Conclusion 
You now have all the tools necessary to edit stereoscopic 3D in Vegas Pro 10. We look forward to seeing your 3D project! 
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